Chapitre 1 : Estimation d’un modéle de régression par la méthode des MCO

Section 1 : Introduction au logiciel Eviews 4.1
I. L’écran d’accueil d’EViews

Pour lancer EViews, il faut cliquer sur I’application « EViews4 ». Ainsi, 1’écran d’accueil
d’EViews ci-dessus s’affiche 1’écran.
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Il. Création d’un nouveau espace de travail ou « Workfile » : La premiére étape consiste a créer un
nouveau espace de travail ou un nouveau « Workfile », qui contiendra 1’ensemble des séries de données
statistiques et les résultats de calcul (séries générées, tables, graphes, équations, ...etc.).

Pour créer un nouveau Workfile, il faut suivre les étapes suivantes :
Etape 01 : Sur la barre des Menus de la fenétre EViews, Sélectionnez :
Menu File > New > Workfile

5=l Fdit Objects View Procs Quick Options Window Help

COpen » Database...
Save Program

Save As... Text File

Close |

Etape 02 : Sur la boite de dialogue « Workfile Range », spécifiez la fréquence ou la périodicité qui
correspond aux séries de données de Workfile a créé (c'est-a-dire, Frequency). Ensuite,
indiquez la premiere et la derniére date ou observation correspondant aux séries de données de
Workfile a créé (c'est-a-dire, Start date et End date ou Start observation et End
observation). Enfin, cliquer sur OK.

Choisir la fréquence Annual (pour les séries de données annelles : spécifier la date de début, Semi-
annual (pour les séries de données semestrielles : spécifier la date de début, par exemple a 1970:01, et la
date de fin, par exemple a 2017:06), Quarterly (pour les séries de données trimestrielles : spécifier la
date de début, par exemple a 1970:01, et la date de fin, par exemple a 2017:04), Monthly (pour les séries
de données mensuelles : spécifier la date de début, par exemple a 1970:01, et la date de fin, par exemple a
2017:12) et Daily (pour les séries de données journalieres : spécifier la date de début, par exemple a 01:
01:2000, et la date de fin, par exemple a 01:01:2011).
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Sur la boite de dialogue « Save As » spécifier le répertoire de destination (enregistrer sous : Mes
Documents, par exemple), le nom du nouveau Workfile créé (Nom du fichier : exo01, par exemple) et le
type de fichier (Workfile : *.wf1).

I11. Création des séries de données
lere Method: Quick — Empty Group ( Edit Series)
2ieme method : Pour créer une nouvelle série de données, il faut suivre les étapes suivantes :

Etape 01 : Sur la barre des menus de la fenétre d’EViews ou sur la barre des menus de la fenétre de
Workfile, sélectionnez :

Menu Objects = New objects
Etape 02 : Sur la boite de dialogue « New Object », spécifié :

— Le type d’objet a créer (Type of object). Pour cela, cliquer sur Series.
— Donner un nom pour la nouvelle série créée (Name of object). Cliquer sur OK
Mew Object =)

Type of object Marne for object

[Urtitled

Equation

Graph

Group

Logl

b atrig-ector-Coef
r odel

Foal

SamEIe

Szpace Cancel
Syztem

Table

Te=t

W H

Une fois vous avez cliquez sur OK de la boite de dialogue « New Object », une nouvelle série de
données est ajoutée a I’espace de données de Workfile. Cette derni¢re porte le nom spécifié dans
« Name for object ».

Etape 03 : Sauvegarder les modifications apportées au Workfile.

— Pour cela, sélectionnez sur le menu File = Save
— Ou bien, cliquer sur le bouton Save de la barre des menus de la fenétre de Workfile



V1. Génération d’une nouvelle série de données a partir des séries existantes

Pour géneérer une nouvelle série a partir des séries existantes, il faut suivre les étapes suivantes :

Etape 01 : Cliquer sur le bouton Genr de la barre d’outils de la fenétre de Workfile ou sur le menu
Quick 2> Generate Series da la barre des menus de la fenétre d’EViews.

Etape 02 : Sur la boite de dialogue « Generate Series by Equation », spécifier I’équation a utiliser pour
générer la nouvelle série de données sous « Enter equation ». L’équation doit étre sous la
forme : Serie_a générer = a + P1 * SerieO1 + B> * Serie02 + ...etc. Ensuite, Spécifiez
I'intervalle sur lequel la nouvelle série de données doit étre générer sous "Sample”. Enfin,
cliquer sur OK de la boite de dialogue « Generate Series by Equation ».

Generate Series by Equation E]
Enter equation
Sample
|1 14|
ok | Cancel |

Etape 03 : Sauvegarder les modifications apportées au Workfile.

— Pour cela, sélectionnez sur le menu File = Save
— Ou bien, cliquer sur le bouton Save de la barre des menus de la fenétre de Workfile.

V. Visualiser ou afficher les données d’une ou plusieurs Séries de données

Pour visualiser ou afficher les données d’une ou plusieurs séries de données statistiques, il faut suivre les
étapes suivantes :

Etape 01 : Sélectionner la ou les série(s) de données pour laquelle ou lesquelles vous voulez afficher les
données, tout on maintenant la touche CTRL enfoncée.

Etape 02 : Cliquer sur la ou les série(s) sélectionnée(s) avec la touche droite de la souris. Ensuite, cliquer
sur Open ou bien Open = As Group.

Y prix
[=] regression as Equation...
M resid Capy as VAR...

as Multiple series

Remarque : Si la série de données est affichée ou visualisée sous la forme d’un graphe, il faut cliquer sur
le bouton Sheet de la fenétre de la série ou bien cliquer sur le menu View ->» SpreadSheet
pour visualiser ou afficher ses données.

IVV. Afficher les statistiques descriptives d’un groupe de séries
Pour afficher les statistiques descriptives d’un groupe de séries, il faut suivre les étapes suivantes :

Etape 01 : Sélectionner les séries de donnees pour lesquelles vous voulez afficher les statistiques
descriptives, tout en maintenant la touche CTRL enfoncée. Ensuite, double clique sur les
séries de données sélectionnées et puis, cliquer sur Open Group.

Etape 02 : Sur la fenétre de groupe, cliquer sur le menu :
Menu View =>» Descriptive Stats = Common Sample



Ainsi, la fenétre de groupe est visualisée sous la forme d’une table qui regroupe les difféerents
calculs statistiques (comme la moyenne, la médiane, 1’écart-type, ...etc.) concernant chaque
série du groupe.

& EViews - [Group: GROUPO1 Workfile: DETERMINANTS EXPORTATIONS] S0 -

1 File Edit Objects WView Procs Quick Options Window Help
view | Procs |Objev::ts | Print | Name | Freeze | Sample | Sheet | Stats | Spec |

EXPO PIB TCH 1INV INF
Mean 2 45E+10 T.59E+10 4013017 2 43E+10 8.971385
Median 1.39E+10 5 42E+10 29.20195 1.48E+10 6.070002
Maximum 5. 20E+10 2 14E+11 1109730 8. 00E+10 31.66966
Minimum 9 _36E+08 4 BEE+09 3.837450 1. 66E+09 0.339163
Std. Devw. 2 33E+10 6_05E+10 35 86199 2 23E+10 7 66ET068
Skewness 1.196150 1.030165 0.297706 1.292881 1.591012
Hurtosis 3.106970 2.834077 1.666666 3.202559 4 779200
Jarque-Bera 11.46908 8.544986 4 875456 13 45439 26 58167
Probability 0.003232 0.013947 0.087359 0.001198 0.000002
Sum 1.18E+12 3. 64E+12 1926 245 1.1TE+12 430 6265
Sum Sq. Dev. 2 RAE+22 1.72E+23 60445 86 2 33E+22 2T62 845
Observations 48 485 48 485 485

Description de la sortie de la table des statistiques descriptives

Mean : La valeur moyenne de chaque série du groupe.

Median : La valeur médiane de chaque série du groupe.

Maximum : La valeur maximale de chaque série du groupe dans 1’échantillon courant.
Minimum : La valeur minimale de chaque série du groupe dans 1’échantillon courant.
Std. Dev. (« Standard Deviation ») : L’écart-type de chaque série du groupe.
Skewness : La valeur de Skewness « S » (coefficient d’asymétrie de la distribution) :

ASANENENENEN

S = % tel que p; est le moment d’ordre k.
2

v Kurtosis : La valeur de Kurtosis « K » (aplatissement / épaisseur des queues) :

K = % tel que u; est le moment d’ordre k.
2

v Jarque-Bera : La valeur de la statistique de Jarque & Bera « BJ » :

BJ = 252+ Z [K —3]% tel que n: La taille de I’échantillon courant.
6 24

S : La valeur de Skewness.
K : La valeur de Kurtosis.

v Probabilité : Probabilité critique (p-value) du test de nullité de I’hypothése de normalité de la
distribution de la série, au seuil & = 0,05

Sum : La somme des valeurs de chaque série de groupe.

Sum Sqg. Dev. (« Sum Squared Deviation ») :

Observations : Le nombre d’observations de 1’échantillon courant.
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Etape 03 : Pour sauvegarder la table statistique sur votre espace de travail ou Workfile, il suffit de cliquer
sur le bouton « Freeze ». Une fenétre « Table », nommée « UNTITLED », s’affiche a 1’écran.

Pour nommer la table statistique créée, il suffit de cliquer sur le bouton Name, ou bien sur le
bouton Objects = Name..., de la fenétre « Table». Sur la boite de dialogue
« Object Name », spécifier le nom de la table statistique.



Mame ta identify abject
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Cancel

Etape 04 : Fermer la fenétre de la table statistique, ainsi que la fenétre de groupe en cliquant sur le bouton
fermer (IX1).

11V. Afficher les statistiques descriptives d’une série de données
Pour afficher les statistiques descriptives d’une série de données, il faut suivre les étapes suivantes :

Etape 01 : Cliquer deux fois sur la série de données pour laquelle vous voulez afficher les statistiques
descriptives. Ensuite, sur la fenétre de la série, cliquer sur le menu :

— Menu View = Descriptive Statistics = Stats Table: Pour afficher la table statistique
qui regroupe les différents calculs statistiques (moyenne, médiane, écart-type, ...etc.).

EXPO

Mean 2.45E+10
Median 1.39E+10
Maximum 8.20E+10
Minimum 9.36E+08
Std. Dev. 2.33E+10
Skewness 1.196150
Kurtosis 3.106970
Jarque-Bera 11.46908
Probability 0.003232
Sum 1.18E+12
Sum Sq. Dev. 2.54E+22
Observations 48

Menu View - Descriptive Statistics - Histogram and Stats : Pour afficher I’histogramme et la table
statistique de la sérié de données.
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Etape 02 : Pour sauvegarder la table statistique ou 1’histogramme et la table statistique sur votre espace
de travail ou Workfile, il suffit de cliquer sur le bouton « Freeze » et ensuite cliquer sur le
bouton Name, ou bien sur le bouton Objects = Name..., de la fenétre « Table » ou de la
fenétre « graph » pour nommer la table ou le graphe crée.

Etape 03 : Fermer la fenétre de la table statistique ou la fenétre de graphe (histogramme et la table
statistique), ainsi que la fenétre de la série en cliquant sur le bouton fermer (IxI).

Etape 04 : Sauvegarder les modifications apportées au Workfile.

— Pour cela, sélectionnez sur le menu File = Save



— Ou bien, cliguer sur le bouton Save de la barre des menus de la fenétre de Workfile.
XII. Afficher le graphique d’une ou plusieurs séries de données
Pour produire le graphique d’une ou plusieurs séries de données, il faut suivre les étapes suivantes :

Etape 01 : Sélectionner la ou les séries de données pour laquelle ou lesquelles vous voulez créer le
graphique, tout en maintenant la touche CTRL enfoncée. Ensuite, double clique sur la ou les
séries de données sélectionnées et puis, cliquer sur Open Group.

Etape 02 : Sur la fenétre de la série ou de groupe, cliquer sur le menu View - Graph - Type de
Graphe. Noter que les difféerents types de graphe qui existe sous EViews sont : « Line, Bar,
Spike, Scatter, XY Line, Error Bar, High-Low (Open-Close), Pie ».

Etape 04 : Pour sauvegarder le graphique sur votre espace de travail ou Workfile, il suffit de cliquer sur
le bouton « Freeze ». Une fenétre Graph, nommée « UNTITLED », s’affiche a I’écran.

Pour nommer le graphique créé, il suffit de cliquer sur le bouton « Name », ou bien sur le
bouton « Objects - Name...», de la fenétre Graph. Sur la boite de dialogue
« Object Name », spécifier le nom du graphe.

X. Afficher le graphe de nuages de points

Pour produire le graphique de nuages de points entre deux séries de données, il faut suivre les étapes
suivantes :

Etape 01 : Sélectionner la série de données a placer dans 1’axe des abscisses ensuite la série de données a
placer dans I’axe des ordonnées, tout en maintenant la touche CTRL enfoncée. Ensuite,
double clique sur les séries de données sélectionnées et puis, cliquer sur Open Group.

Etape 02 : Sur la fenétre de la série ou de groupe, cliquer sur le menu
— Menu View = Graph = Simple Scatter : Pour afficher le graphe de nuages de points.

— Menu View = Graph -> Scatter with Regression : Pour afficher le graphe de nuages
de points et la droite de régression

Etape 03 : Pour sauvegarder le graphe de nuages de points sur votre espace de travail ou Workfile, il
suffit de cliquer sur le bouton « Freeze » et ensuite cliquer sur le bouton Name, ou bien sur le
bouton Objects = Name... ,de la fenétre « graph » pour nommer le graphe crée.

Section 2 : Estimation d’un modéle de régression par la méthode des MCO sous EViews

Pour estimer, sous EViews, les parametres d’un modéle de régression linéaire simple ou multiple en
utilisant la méthode des Moindres Carrés Ordinaire (MCO), il faut suivre les étapes suivantes :

Etage 01 : Sur la barre des Menus de la fenétre EViews, Sélectionnez :
Menu Quick = Estimate Equation...

File Edit Objects WView Procs ellaql Options Window Help
T Sample... 1
Generate Series...
Show ...

Graph »
Empty Group (Edit Series)
Series Statistics »
Group Statistics »
Estimate Equation...

Estimate VAR...

Etape 02 : Sur la boite de dialogue « Equation Specification », spécifiez :

Sur le champ « Equation specification » rentrer dans 1’ordre la variable a expliquer, la constante
C et la ou les variable(s) explicative(s), séparés par un espace. C'est-a-dire, sous la forme suivant :



Variable a expliquer C Variable explicativel Variable explicative?2 ...

v' La méthode de régression : Sur le champ « Method », spécifier la méthode de régression a
utiliser pour I’estimation des parametres de la régression. Dans notre cas, on utilise la méthode des
Moindres Carrés Ordinaire (MCO) < Ordinary Least Squares (OLS)

v' L’échantillon : Sur le champ « Sample », spécifier la taille de I’échantillon sur laquelle le

modele de régression est appliqué.
Eq_u ation Specification L&J

E quation =pecification
Dependent wariable folloveed by lizt of regressors including AR kA
and PDL terms, OFR an explicit equation like v'=c[1]+c[2]%.

ExPO C FIE TCH IMNF -

E stimation settings
-

kM ethod: |LS - Least Squares [MLS and ARRA)

Cancel
Sample: |1 970 2017 - g
= Options

Une fois les trois parametres de la boite de dialogue « Equation Specification » sont spécifiés,
cliquer sur OK. Ainsi, une fenétre « Equation » apparait a 1’écran. Cette derniére contient les valeurs
estimées pour les différents parametres de modeéle de régression étudié.

Dependent Variable: EXPO
Method: Least Squares
Date: 02/25/19 Time: 16:21
Sample: 1970 2017
Included observations: 48
Variable Coefficient  Std. Error  t-Statistic Prob.
C 3.18E+08 2.99E+09  0.106440  0.9157
PIB 0.346619  0.031454  11.01981  0.0000
TCH 2034941. 53991394  0.037690 0.9701
INF -2.44E+08 1.77E+08 -1.381044 0.1742
R-squared 0.868952 Mean dependent var 2.45E+10
Adjusted R-squared 0.860017 S.D. dependent var 2.33E+10
S.E. of regression 8.70E+09  Akaike info criterion 48.69044
Sum squared resid 3.33E+21  Schwarz criterion 48.84638
Log likelihood -1164.571  F-statistic 97.25199
Durbin-Watson stat 0.332981  Prob(F-statistic) 0.000000

Description des résultats de la sortie de la régression

La premiére zone de la fenétre « Equation » contient des informations générales sur la modéle de
régression étudié :

v Ligne 01 : Nom de la variable dépendant ou de la variable a expliquer.

v Ligne 02 : Méthode de la régression utilisée.

v" Ligne 03 : Date et I’heure de 1’exécution de la régression.

v' Ligne 04 : La taille de I’échantillon sur laquelle la régression est exécutée.
v Ligne 05 : Nombre d’observation de 1’échantillon sur laquelle la régression est exécutée.

La deuxieme zone de la fenétre « Equation » contient les différentes valeurs estimées pour les
coefficients de modeéle de régression étudie.

v Colonne 01 : Noms des coefficients de modéle de régression étudié : C(1), C(2), ..., C(k).

v" Colonne 02 (« Coefficients ») : Valeurs estimées pour les coefficients de modéle de régression
étudié : By, B, ..., Pr.

v Colonne 03 (« Std. Error » ou « Standard Error ») : Valeurs estimées pour les écart-types des
coefficients estimés : §(B;), 6(5,), ..., 8(By).



v" Colonne 04 (« t-Statistic » ou « Statistique de Student ») : Valeur du t de Student calculé :
_ Bk
e = 530 o _ N
v Colonne 05 (« Prob ») : Probabilité critique (p-value) du test de nullité des coefficients de modéle
de régression étudié. Pour un risque de 5%, si Prob < 0,05 > on rejette I’hypothése {Ho : 8; = 0}
et on accepte I’hypothése {H1 : 5; # 0}.

La troisieme zone de la fenétre de 1’équation contient les valeurs calculées pour les différents calculs
statistiques.

v R-squared (« R au carré »): Valeur calculée pour le coefficient de détermination (R?).

v' Ajusted R-squared (« R au carré ajusté »): Valeur calculée pour le coefficient de détermination
ajusté (R?).

v' S. E. of regression (« Standard Error of regression ») : Valeur estimée pour 1’écart-type des
résidus de la régression (4).

v" Sum squared resid (« Somme des carrés des résidus ») : Valeur calculée pour la Somme des

Carrés des Résidus (SCR=Y €7 ).

Log likelihood : Valeur calculée pour le Log-vraisemblance pour les parameétres estimés.

Mean dependent var : Moyenne de la variable dépendante.

S. D. dependent var (« Standard Deviation of the dependent var ») : Ecart-type de la variable

dépendante.

Akaike info criterion : Critére d’ Akaike (AIC).

Schwarz criterion : Critere de Schwarz (BIC ou SC).

Durbin-Watson stat : Statistique du Durbin-Watson.

ANANRN
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Etape 03 : Cliquer sur le bouton Name de la fenétre « Equation » pour enregistrer I’équation de modéle
régression étudié. Ainsi, une boite de dialogue nommé « Object Name » apparait a 1’écran.

Mame to identify abject

24 characters masimum,

|N0m_équati0n_regressiori 1E or fewer recommended

Ciizplay name for labeling tables and graphs [optional]

|

Sur cette boite de dialogue « Object Name », spécifier le nom de 1’équation de modéle de régression
étudié dans le champ « Name to identify object » et ensuite cliquer sur OK. Ainsi, une nouvelle équation
est ajoutée a I’espace de données de Workfile. Cette derniére porte le nom spécifié dans « Object Name ».

Etape 04 : Fermer la fenétre « Equation » en cliquant sur le bouton fermer (XI).
Etape 05 : Sauvegarder les modifications apportées au Workfile.

— Pour cela, sélectionnez sur le menu File = Save
— Ou bien, cliguer sur le bouton Save de la barre des menus de la fenétre de Workfile.

Afficher le graphique des résidus de la régression

Pour afficher le graphique des résidus de la régression, il suffit de cliquer sur le bouton « Resids »
ou bien sur le Menu « View => Actual, Fitted, Residual - Actual, Fitted, Residual Graph » de la
fenétre de I’équation de la régression.
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Residual : Le graphe des résidus de la régression &;.
Actual : Le graphe de la variable endogéne observée (Y).
Fitted : Le graphe de la variable endogéne estimée (Y).

Pour afficher le tableau de données de ces trois séries (Residual &;, Actual Y, Fitted Y ), il suffit de

cliquer sur le Menu « View => Actual, Fitted, Residual = Actual, Fitted, Residual Table ».
EH EViews - [Equation: EQO1  Workfile: DETERMIMAMNTS EXPORTATIONS]
3 File Edit Objects View Procs Quick Options Window Help
Wieww | Procs | Objects | Prirt | MName | Freeze | Estimate | Forecast |Stats | Resids |
obs | Actual | Fitted [Residual Residual Plot
1970 1.1E+09 4 0E+08 6.7E+08 I
1971 94E+08 1 4E+09 -51E+08

I
I I

1972 14E+09 1.8E+09 -4 0E+08 ! !
1973 | 2.2BE+09 1.8E+09 3.8E+08 ! !
I I

1 1

I I

1974 51E+09 3.8E+09 1.4E+09

1975 52E+09% 3 7VE+09 1.5E+09

1976 59E+09 4 2E+09 1.7E+09
Pour afficher le graphe des résidus de la régression, il suffit de cliquer sur le Menu « View - Actual,
Fitted, Residual = Residual Graph.
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Afficher la matrice des variances-covariances des coefficients: Pour afficher la matrice des
variances-covariances des coefficients de la regression, il suffit de cliquer sur le Menu « View =>»
Covariance Matrix » de la fenétre de 1’équation de la régression.

Bl EViews - [Equation: EQO1 Workfile: DETERMINANTS EXPORTATIONS] -4

—l File Edit Objects View Procs Quick Options Window Help

iew|Pmcs|Objects| F‘rint|Name|Freeze| Estimate|Fc:reu:ast|5tats|ﬂesids|

C PIB TCH INF
C 8.94E+18 | 29712656 | 4. 14E+16 | -3.84E+17
PIB -29712656 0.000984 -1214663. 3769321
TCH 4. 14E+16 | -1214668. 2 92E+15 1.85E+15

INF -3.84E+17 3769321 1.85E+15




Tester la normalité des erreurs (test de Jarque - Bera) : Pour tester la normalité des erreurs de la
régression, il suffit de cliquer sur le Menu « View ->» Residual Tests - Histogram — Normality
Test » de la fenétre de I’équation de la régression.

XIX. Tester ’autocorrelation des erreurs : Pour tester I’autocorrelation des erreurs de la régression,
il suffit de cliquer sur le Menu « View =-> Residual Tests = Correlogram — Q-statistics » de la
fenétre de 1’équation de la régression.

16
Series: Residuals
14 — Sample 1970 2017
Observations 48
12
Mean -3.34E-06
104 Median 1.32E+09
8 Maximum 2.35E+10
Minimum -2.11E+10
6 Std. Dev. 8.42E+09
Skewness -0.076790
4 Kurtosis 4.410788
2 4 y—ﬂ y—ﬂ Jarque-Bera  4.027817
Probability 0.133466
0 H———7T—— L [j\

-1.2E+10 0.00000 1.2E+10 2.5E+10

La probabilité associée a la statistique de Jarque-Bera ( 0.13) est supérieure a 0,05. L'hypothése de
normalité des résidus est donc vérifiée. Nous pouvons donc conclure que les résidus de I'estimation du
modele sont stationnaires. La normalité de leur distribution est confirmée.

Autocorrelation d’ordre 1 : Test de Durbin et Watson
Autocorrelation d’ordre supérieur a 1 : Test de Ljung et Box

Date: 02/25/19 Time: 20:12
Sample: 1970 2017
Included observations: 48

Autocorrelation Partial Correlation AC PAC Q-Stat Prob

0.777 0.777 30.858 0.000
0.533 -0.181 45666 0.000
0.300 -0.127 50.458 0.000
0.118 -0.046 51.216 0.000
-0.022 -0.067 51.243 0.000
-0.129 -0.075 52.187 0.000
-0.251 -0.192 55.864 0.000
-0.351 -0.113 63.247 0.000
-0.430 -0.131 74.605 0.000

LO~NOOMEWN-=

Autocorrelation : Corrélogramme de la fonction d’autocorrelation simple.
Partial Correlation : Corrélogramme de la fonction d’autocorrelation partielle.
AC : Fonction d’autocorrelation simple.

PAC : Fonction d’autocorrelation partielle.

Q-Stat : Statistique Q de Ljung et Box.

Prob : Probabilité critique de Ljung et Box.

Aprés observation du corrélogramme des résidus nous constatons que les résidus se retrouvent a I
extérieur de l'intervalle de confiance.



